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SECTION 1: MSAR PROCESS AND GENERAL GUIDANCE 

1.1. OVERVIEW 

The purpose of this document is to provide Office of the Assistant Secretary of Defense for 
Acquisition (ASD(A))/Acquisition Data and Analytics (ADA) guidance for completing 
Modernized Selected Acquisition Reports (MSARs) for Major Capability Acquisition (MCA) 
programs.  This guidance replaces “Major Capability Acquisition Data Guidance” issued 12 Dec 
2022 by the Acting Deputy Assistant Secretary of Defense, Acquisition Enablers. 

Section 805(c)(2) of the National Defense Authorization Act (NDAA) for Fiscal Year (FY) 2022 
(Public Law 117-81) directed the Under Secretary of Defense for Acquisition and Sustainment 
(USD(A&S)) to submit the Department of Defense (DoD) plan to effectively share acquisition 
data using new reporting systems for covered programs previously requiring Selected 
Acquisition Reports (SARs). Section 809 of the FY 2023 NDAA provided additional direction 
that the new reporting system would replace the requirements of the existing SAR statute (title 
10 U.S. Code § 4351), which terminated at the end of FY 2023.  The USD(A&S) Implementation 
Plan for the Department of Defense’s Modernized Selected Acquisition Report Process dated 
June 2023 responded to requirements directed in Section 805 of the FY 2022 NDAA, in 
coordination with the Director, Cost Assessment and Program Evaluation (CAPE) and the Chief 
Digital and Artificial Intelligence Office (CDAO).  The term “Modernized Selected Acquisition 
Report,” or “MSAR” refers to the new acquisition reporting system that has replaced historical 
SARs. 

The USD(A&S) MSAR Implementation Plan included data requirements not yet supported by 
the Defense Acquisition Visibility Environment (DAVE) Program Registration and Program 
Progress Submission (PPS) capabilities.  Therefore, a portion of the MSAR will be created and 
published in DAVE (whose data guidance is in Section 2), and a portion will be created and 
published using a Microsoft® Excel®-based MSAR Supplement data collection workbook 
(hereafter, “the Workbook”, whose data guidance is in Section 3).   

The data published in DAVE and the Workbook will be transmitted to the Advana Congressional 
Stream.  The MSARs will also be published in Portable Document Format (PDF) and posted to 
the publicly accessible Washington Headquarters Services (WHS) Freedom of Information Act 
Reading Room. 

Appendix A lists Common DoD Abbreviations that may be used within the MSAR; all other 
abbreviations must be defined. Appendix B provides instructions for publishing the MSAR 
Supplement PDF from data in the Workbook and submitting the data and PDF to ADA. 

For each program, ADA will merge the DAVE PDF with the Workbook PDF into a single 
MSAR PDF. 

Significant MSAR process and data guidance changes are highlighted in blue font. 
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References: 

a. WHS Reading Room  
https://www.esd.whs.mil/FOIA/Reading-Room/Reading-Room-List_2/Selected_Acquisition_Reports/   

b. Technical assistance using DAVE  
https://dave.acq.osd.mil/help/Program_Progress_HELP or osd.dave@mail.mil  

c. Technical assistance using the MSAR Supplement Workbook  
https://dave.acq.osd.mil/help/Selected_Acquisition_Report_HELP  or osd.sardata@mail.mil 

1.2. APPLICABILITY, TIMING AND FREQUENCY 

a. MSAR: Within 60 days after the date on which the President transmits the Budget to 
Congress for the following fiscal year, Component Acquisition Executives (CAEs) will 
submit MSARs to OUSD(A&S) for all current Major Defense Acquisition Program 
(MDAP) and Major Subprograms that—as of the end of the first quarter of the fiscal year 
(December 31)—  

(1) have entered the Engineering and Manufacturing Development or Production and 
Deployment phase,  

(2) have reasonable cost estimates established by their Milestone Decision Authorities in 
Acquisition Program Baselines (APBs),  

(3) have well-defined system configurations, 

(4) have not yet delivered 90 percent of their end-items defined by their APB, and 

(5) have not yet made 90 percent of planned expenditures of their estimated acquisition 
costs. 

CAEs will also submit MSARs for any other programs if specifically directed by 
USD(A&S) or Congress. 

The Effective Date of the MSAR will be the nominal date December 31 of the current 
fiscal year.  However, data must be current as of the date of the President’s Budget (PB) 
submission.  

b. Exception MSAR: Within 60 days after the end of the second, third or fourth fiscal year 
quarter, CAEs will submit MSARs to OUSD(A&S) for any MDAPs or Major 
Subprograms that have experienced Significant or Critical Cost Growth0F

1. If the CAE 
makes a cost growth determination during the second fiscal year quarter but before the 

 
1 10 USC § 4371 

https://www.esd.whs.mil/FOIA/Reading-Room/Reading-Room-List_2/Selected_Acquisition_Reports/
https://dave.acq.osd.mil/help/Program_Progress_HELP
mailto:osd.dave@mail.mil
mailto:osd.sardata@mail.mil
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PB submission, the cost growth details will be included in the MSAR and a separate 
Exception MSAR is not required.1F

2  

The Effective Date of the Exception MSAR will be March 31, June 30 or September 30, 
and data must be current as of that date. 

1.3. CLASSIFICATION 

a. MSARs will be submitted in publicly releasable, unclassified form without any 
designation relating to dissemination control, but may contain a classified annex if 
specifically requested.    

b. DAVE MSAR data on the Non-classified Internet Protocol Router Network (NIPRNet): 

(1) Ensure Program Registration information that appears in the PPS (such as the Mission 
and Description narrative) contains no Controlled Unclassified Information (CUI) or 
classified information. 

(2) Ensure current estimates and other information provided in the PPS contain no CUI 
or classified information.  Use the indicator at the top of each PPS data sections to 
specify whether classified data exists and is reported in a SIPR MSAR annex that has 
been specifically requested.  

(3) The NIPR DAVE PPS may reference CUI APB data, however—   

(a) Components must manually redact this data from the exported PDF report.  See 
Appendix C for instructions.  

(b) ADA must redact any CUI data from the DAVE PPS data before transmitting it to 
the Advana Congressional Stream. 

c. Classified MSAR Annexes are not required and will only be submitted to OUSD(A&S) if 
specifically requested: 

(1) Complete a DAVE MSAR Classified Annex on the Secret Internet Protocol Router 
Network (SIPRNet) to provide any data up to the SECRET//NOFORN classification.  
It is not necessary to provide Unclassified data in the Classified Annex unless it is 
needed for context. 

(2) Ensure the PPS is portion-marked in accordance with DoDM 5200.01, Volume 2. 

d. MSAR Supplement Workbook:  

(1) The Workbook data file is marked CUI because hidden sheets contain CUI data. 

 
2 10 USC § 4375 (a) 
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(2) Ensure data entered into the Workbook and viewable in the published PDF contain no 
CUI or classified information.  The PDF created from the Workbook data will be 
marked UNCLASSIFIED.   

(3) The top of each section of the workbook includes a checkbox the data provider should 
use to indicate that some data in the section cannot be reported because it is not 
Unclassified.  There will be no classified annexes for the MSAR Supplement.  

1.4. GENERAL GUIDANCE 

a. All acronyms and other abbreviations should be spelled out the first time they appear in 
each section unless they are included in a list of Common DoD Abbreviations with the 
submission (see Appendix A).  The program’s official short name may be used in all data 
sections (the full name does not need to be used). 

b. Actual dates in narratives should formatted Month Day, Year (December 20, 2019). 
Stand-alone fiscal year references should be represented as FY YYYY (FY 2020), base 
year references should be represented as BY YYYY (BY 2020).  Using “CY” for 
calendar year should be avoided since it can be confused with constant year.  In 
structured data, estimated dates are formatted Mmm YYYY, and actual dates are 
formatted D Mmm YYYY, or M/D/YYYY, depending on the context.    

c. OSD CAPE has cancelled “Base Year dollars” (BY$) as a valid dollar type because it can 
be taken to mean Constant Year dollars (CY$) or Constant Price (CP$).  However, CAPE 
agrees that the term “Base Year” is still a valid reference to the year in which a cost 
estimate is approved for a Development or Production Acquisition Program Baseline. 

(1) While the DAVE user interface still uses BY$ labels, program offices should ensure 
CY$ estimates are provided in both DAVE and the MSAR Supplement Workbook, 
and ensure the Workbook correctly identifies the Source for Then-Year dollars (TY$) 
to CY$ Conversions (see Sections 3.10 and 3.13).   

(2) The PDFs generated from DAVE and the Workbook will display CY$ labels, and in 
the future the DAVE user interface will be updated as well. 
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SECTION 2: DAVE MSAR DATA GUIDANCE 

2.1. PROGRAM DESCRIPTION AND RESPONSIBLE OFFICE 

Prior to initiating a DAVE Program Progress Submission (PPS) for the MSAR, review all 
program and subprogram registration data (also known as Program Attributes) in DAVE for 
accuracy and completeness.  Updates cannot be made once a draft PPS is in progress.  Refer to 
the DAVE Program Attributes User Guide for program registration instructions at 
https://dave.acq.osd.mil/help/Program_Registraion_HELP . Allocate sufficient time to allow 
CAE staff and the OASD(A) MDAP Gatekeeper to approve updates to program registration data. 

This following data will be displayed or used within the MSAR: 

a. Program Full Name, Short Name, PNO 

b. Lead Component, Milestone Decision Authority, Program Executive Office 

c. Joint Program Indicator, Supporting Component(s), Federal Partners 

d. International Partner(s): must be identified in Program Attributes before initiating the 
PPS in order to report Foreign Military Sales cases and International Agreements in the 
International Program Aspects section 

e. Adaptive Acquisition Pathway, Acquisition Type, Acquisition Category 

f. Acquired System(s): the official designation (e.g., Type/Model/Series, Mission Design 
Series) of the system and system variants the program will acquire or modify.   

(1) MSAR Operating and Support (O&S) cost estimates are provided by acquired system 
since each may have significantly different characteristics and planned usage.  Annual 
Acquisition Quantities and the Operational Fielding Plan are have also provided by 
acquired system. 

(2) Acquired Systems must be identified in Program Attributes before initiating the PPS 

g. Antecedent System(s): the official designation of the system(s) each acquired system is 
replacing.  Not displayed in the MSAR Program Description section but must be 
identified in Program Attributes to report unitized O&S cost comparisons with Acquired 
Systems. 

h. Acquisition Status 

i. Mission & Description 

j. Program Executive Officer: full name, email address and phone number 
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k. Program Manager: full name, email address and phone number 

2.2. PPS INITIALIZATION 

a. Effective Date:  

(1) MSAR: December 31 

(2) Exception MSAR: March 31, June 30 or September 30 

b. Programs with Subprograms: at this time, the DAVE PPS does not enable the data 
provider to exclude a subprogram from the MSAR (all are included).  However, if no 
data is provided in a given data section for a subprogram, then that subprogram’s 
subsection of data will be omitted from the published PDF report (e.g., a table of 
schedule baseline events for that subprogram will not be displayed if no PPS schedule 
data is provided). 

c. APB References: identify for the MDAP—or for each Major Subprogram—its: 

(1) Current Baseline: The most recent APB approved prior to the MSAR submission.   

(2) Milestone Baseline, formerly known as SAR Baseline: The APB approved at MS A 
(if any), MS B or MS C. 

(3) Original Baseline2F

3: The APB approved at MS B or at Program Initiation whichever 
occurred later.  When a program is recertified following a Critical Nunn-McCurdy 
Breach, a Revised Original Baseline replaces the Original Baseline for unit cost 
reporting. 

d. Providing these baseline references ensures that current estimates for schedule, 
performance, cost, and unit cost are displayed in the context of the baseline data. 

2.3. EXECUTIVE SUMMARY 

Provide a Program Highlights narrative and a History of Significant Events for the program.  For 
an MDAP with Major Subprograms, this information can be provided for the overall MDAP or 
for each subprogram at the discretion of the Component Acquisition Executive. 

a. Program Highlights Since Last Report (DoD Only): this narrative is not applicable for 
the MSAR and will not be displayed within the published report PDF. 

b. Program Highlights Since Last Report (For Release to Congress): this is not a 
program history (“old news”) unless that information is necessary to explain current 

 
3 10 USC § 4214 (d) 
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developments.  The narrative should correspond to the data in the rest of the Program 
Progress data sections. 

(1) If this is the initial MSAR for the program or subprogram, insert: “This is the initial 
MSAR submission for the [program name] MDAP” (or “for the [subprogram name] 
Major Subprogram”).  The summary should typically also include a brief chronology 
of program activities to date. 

(2) If this is the final MSAR for the program or subprogram, insert the appropriate 
statement: 

(a) “This is the final MSAR submission for the [program name] MDAP (or “for the 
[subprogram name] Major Subprogram”) because it has delivered 90 percent of 
its end-items defined by its Acquisition Program Baseline (APB).” 

(b) “This is the final MSAR submission for the [program name] MDAP (or “for the 
[subprogram name] Major Subprogram”) because it has made 90 percent of 
planned expenditures of its estimated acquisition cost.” 

(c) “This is the final MSAR submission for the [program name] MDAP (or “for the 
[subprogram name] Major Subprogram”) because it has delivered 90 percent of 
its end-items defined by its Acquisition Program Baseline (APB) and has made 90 
percent of planned expenditures of its estimated acquisition cost.” 

(d) “This is the final MSAR submission for the [program name] MDAP (or “for the 
[subprogram name] Major Subprogram”), because it has been cancelled.” 

(e) “This is the final MSAR submission for the [program name] program, because it 
no longer meets the definition of a Major Defense Acquisition Program pursuant 
to Section 4201 of title 10, United States Code.” 

(3) Exception MSAR Rationale, if applicable, e.g., “This Exception MSAR reports 
critical cost growth for the [program name] MDAP (or “for the [subprogram name] 
Major Subprogram”): APUC has increased 28% above the current APB.” 

(4) Major milestone decisions. 

(5) Major contract awards or modifications. 

(6) Funding Status: Reprogramming actions, significant Congressional marks and 
enacted Overseas Contingency Operations (OCO) or other supplemental funding. 

(7) APB deviations, status of required Program Deviation Reports to the MDA and plans 
to resolve or mitigate the deviations. 
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(8) Status of Developmental Test and Evaluations or Operational Test and Evaluations, if 
applicable, or estimates when testing will commence.  Reliability Growth Chart 
(RGC) submissions are required once system-level testing begins. 

(9) Status of Milestone B Certifications3F

4: When MDA has waived one or more 
certifications required by Section 4252 of title 10 U.S.C., “Prominently and clearly 
indicate that MDAP or Major Subprogram has not fully satisfied all the certification 
requirements [until all certification requirements are satisfied].” 

(10) Defense Cost and Resource Center (DCARC) Cost and Software Data 
Reporting (CSDR) Compliance Rating: Specify latest rating for the program.  

(a) Example: “Defense Cost and Resource Center Cost and Software Data Reporting 
Compliance Rating: Green.” 

(b) Green:  No open CSDR compliance issues 

(c) Green Advisory: All outstanding CSDR deliverables are less than or equal to 
three months overdue 

(d) Yellow: Any outstanding CSDR deliverables greater than three months, but less 
than or equal to six months overdue 

(e) Red: Any outstanding CSDR deliverables greater than six months overdue, or 
formally rejected CSDR deliverables outstanding greater than 30 days overdue 

(f) Red-Critical: Program Office issues or long-term outstanding submissions 

(g) Not Rated 

(11) MSAR following Critical Cost Growth when program is restructured instead of 
terminated4F

5: Description of funding changes made following a report of Critical 
Cost Growth in the program (aka “a Critical Nunn-McCurdy Breach”), including 
reductions made in funding for other programs to accommodate such cost growth. 

(12) Modular Open System Approach: Summary description of the key elements, or 
rationale for not using a modular open system approach. This is not required for 
programs achieving Milestone B approval before January 1, 2019. 

(13) Software Component Significant Changes:  

(a) Significant changes in schedule events and rationale. 

(b) Significant changes in expected performance and rationale. 

 
4 10 USC § 4252 (e)  
5 10 USC § 4377 (a)(4) 
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(c) Significant changes in development or procurement cost and rationale. 

(d) If no significant changes exist, state, “There are no significant software-related 
issues with this program at this time.” 

(14) Business Base Considerations: Summarize Foreign Military Sales impacts to the 
cost or schedule of the program because of such agreements. 

c. History of Significant Developments Since Program Initiation: list major program 
events (especially those not included in the schedule section) such as capability 
requirement document validations, major contract awards, significant test periods, 
production delivery, Congressional adjustments, Nunn-McCurdy unit cost breaches and 
major program restructures.  List in reverse-chronological order. 

2.4. SCHEDULE 

a. Schedule Baseline Events:  

(1) Event Grouping: When possible and applicable, group together related events as they 
are arranged in the Schedule Baseline, especially those that support critical 
technologies or components critical to the program’s success.  

(2) Provide updated estimates for future events.   

(3) Provide actual dates for completed events.   

(4) Ensure schedule event deviations are indicated when the estimated or actual date is 
later than the APB threshold date. 

b. Other Significant Engineering Events: Provide estimates or actual dates for events such 
as System Readiness Reviews (SRR), Preliminary Design Reviews (PDR), and Critical 
Design Reviews (CDR) that do not exist in the schedule baseline.  If these events are not 
in the Schedule Baseline, create and add them to the table of Schedule Events. 

c. Schedule Baseline Deviation Explanation: provide an explanation when at least one 
schedule event deviation exists.  

(1) Explain new deviations.  

(2) If an event deviation existed in the prior MSAR, provide an explanation if the 
estimate has slipped more than three months since the prior MSAR. Otherwise, the 
explanation need only note that the deviation was reported previously.  For example, 
“The MS C deviation was reported in the December 2022 MSAR.” 

d. Schedule Notes: Provide any amplifying information about the program schedule. Note 
the status of any APB revision to correct a deviation or the submission of a Program 
Deviation Report (PDR). 
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e. Significant Schedule Risks:   

(1) Identify current schedule risks as of the date of the MSAR submission. 

(2) Identify prior risks that existed at the time of each the milestone review.  

(3) Provide negative statements if applicable, e.g., “There are currently no schedule 
risks,” or “There were no schedule risks identified at Milestone B.” 

2.5. PERFORMANCE 

a. Performance Baseline Attributes:  

(1) Performance Attribute Grouping: When possible and applicable, group together 
related attributes as they are arranged in the Performance Baseline. 

(2) Provide updated current estimates for all system performance attributes (Key 
Performance Parameters, Key System Attributes, and Additional Performance 
Attributes).  

(3) Ensure performance attribute deviations are indicated when current estimates do not 
meet APB threshold criteria. 

(4) Demonstrated Performance:  Indicate performance measured during developmental 
testing (and date measured), or state “TBD” if an attribute has not yet been tested.  If 
an attribute’s demonstrated performance is still TBD once the program reaches 
Production (i.e., Milestone C), explain in the Performance Notes. 

b. Performance Baseline Deviation Explanation: provide an explanation when at least 
one performance attribute deviation exists.  

(1) Explain new deviations and deviations for estimates that have changed significantly 
since the prior MSAR. 

(2) For previously reported deviations, the explanation need only note that the deviation 
was reported previously.  For example, “The Interoperability KPP deviation was 
reported in the December 2022 SAR.” 

c. Performance Notes: Provide any amplifying information about the system performance. 
Explain any “TBD” demonstrated performance after a program has entered production.  
Note the status of any APB revision to correct a deviation or the submission of a Program 
Deviation Report (PDR). 

d. Requirement Source: APB Requirement Sponsors and Capability Requirements 
Document types and validation dates will be displayed. 
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2.6. ACQUISITION BUDGET ESTIMATE 

a. OSD CAPE has cancelled “Base Year dollars” (BY$) as a valid dollar type because it can 
be taken to mean Constant Year dollars (CY$) or Constant Price (CP$).  

(1) While the DAVE user interface still uses BY$ labels, program offices should ensure 
CY$ estimates are provided in both DAVE and the MSAR Supplement Workbook, 
and ensure the Workbook correctly identifies the Source for TY$ to CY$ Conversions 
(see Sections 3.9 and 3.10). 

(2) The PDFs generated from DAVE and the Workbook will display CY$ labels, and in 
the future the DAVE user interface will be updated as well. 

(3) The inflation indices for TY$ to CY$ conversions in the MSAR Supplement 
Workbook come from ASN FMB-6 and SAF/FMCE but it usually takes these 
organizations about a month and a half to two months to update their inflation indices 
after OSD(C) releases inflation guidance (which in 2023 did not happen until 7 Feb).  
The workbook will be updated as soon as possible after receipt of ASN FMB-6 and 
SAF/FMCE indices. 

b. Cost Units: Set to $Millions unless program has very low unit costs that require reporting 
in $Thousands.  Cost units will be consistent throughout the report. 

c. Budget Position: Set to President’s Budget (PB). 

d. Budget Year: Set to the first fiscal year of President’s Budget Future Years Defense 
Program (FYDP).  E.g., the December 2023 MSAR should have a 2025 budget year. 

e. Base Year: Must match the Base Year of the Current APB 

f. Appropriation Category Current Estimates  

(1) Acquisition Appropriation Categories align to Public Law titles:  

(a) Research, Development, Test & Evaluation (RDT&E) 

(b) Procurement 

(c) Military Construction (MILCON) 

(d) Operation & Maintenance (O&M): Only include funds related to the program’s 
Acquisition Cost, not Operating & Support (O&S) Cost 

(e) Revolving & Management Funds (R&MF): Only include Working Capital Funds 
related to the program’s Acquisition Cost, not O&S Cost 

(2) For each Appropriation Category, provide the program manager’s estimate to 
complete the approved program (not efforts outside the scope of the APB), but 
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constrained by the PB. For this reason, it is also called an Acquisition Budget 
Estimate and includes:   

(a) Actual prior obligations for expired appropriations, 

(b) Current budget authority for enacted appropriations, 

(c) Current FYDP budget for the approved (baselined) program, and 

(d) PM’s estimate to complete approved (baselined) program beyond the FYDP. 

(e) Provide estimates in then-year dollars (TY$) and base-year dollars (BY$). Ensure 
these appropriation category totals match the calculated totals in the MSAR 
Supplement Workbook (see Section 3.9). 

(f) Ensure an Appropriation Category Deviation is indicated if the base year estimate 
is greater than the APB base year threshold. 

(g) Deviation Explanation: provide an explanation when an appropriation category 
deviation exists.  

(i) Explain new deviations.  

(ii) If an appropriation category deviation existed in the prior MSAR, provide an 
explanation if the estimate grown more than 5% since the prior MSAR.  
Otherwise, the explanation need only note that the deviation was reported 
previously.  For example, “The RDT&E deviation was reported in the 
December 2022 SAR.” 

g. Program End-Item Quantities: provide the number of fully configured end items to be 
acquired for the planned program: 

(1) Total Development Quantity  

(2) Total Procurement Quantity  

(3) Total O&M-Acquired Quantity: very rare and only approved by Component 
Comptroller if the end items cost is less than the investment/expense threshold. 
Consult CAE reporting staff before this type of acquisition end-item quantity is 
provided. 

(4) Ensure the Program End-Item Quantities match the totals calculated in the MSAR 
Workbook (Section 3.9 below) 

h. Program Acquisition Unit Cost (PAUC) and Average Procurement Unit Cost 
(APUC) Current Estimates: Calculated using acquisition estimates and end-item 
quantities. 
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(1) Ensure a PAUC or APUC Deviation is indicated if the base year estimate is greater 
than the corresponding base year threshold. 

(2) Deviation Explanation: provide an explanation when a deviation exists.  

(a) Explain new deviations. 

(b) If a unit cost deviation existed in the prior MSAR, provide an explanation if the 
estimate grown more than 5% since the prior MSAR.  Otherwise, the explanation 
need only note that the deviation was reported previously.  For example, “The 
PAUC deviation was reported in the December 2022 SAR.” 

(3) Ensure PAUC and APUC estimates match values calculated in the MSAR Workbook 
(Section 3.9 below). 

i. Budget and Quantity Notes: Provide any amplifying information about the acquisition 
budget estimate and planned end-item quantities. Note the status of any APB revision to 
correct a deviation or the submission of a Program Deviation Report (PDR). 

j. Risk and Sensitivity Analyses:  

(1) Identify current risks with the Procurement Cost Estimate as of the date of the MSAR 
submission. 

(2) Cost risks identified in the Original (or Revised Original) and Current APBs are 
displayed in the MSAR for reference. 

2.7. UNIT COSTS 

This section of the MSAR displays the Unit Cost Report (UCR) for the MDAP or each Major 
Subprogram. It includes comparisons of the program's current estimates for PAUC and APUC 
with the unit costs in the Current Baseline and Original Baseline. A unit cost breach exists when 
the program has experienced Significant Cost Growth or Critical Cost Growth as defined in 10 
USC § 4371. This is also known as a “Nunn-McCurdy Breach.” 

a. Current Estimate Compared with Current Baseline: This table displays the percent 
difference in the PAUC and APUC estimates from the Current APB objective values.  It 
displays Significant and Critical Cost Growth indications if criteria are met. 

b. Current Estimate Compared with Original Baseline: This table displays the percent 
difference in the PAUC and APUC estimates from the Original (or Revised Original) 
Baseline objective values and displays Significant and Critical Cost Growth indications.  
In cases where the Original APB and Budget Estimate have different Base Years, provide 
deflated Budget Estimates to enable the appropriate comparison. 

c. Significant or Critical Cost Growth Details:  
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(1) If the Service Acquisition Executive determines that the program has not breached the 
significant or critical cost growth threshold despite calculated indications, the PM 
should explain this in the Unit Cost Notes. 

(2) If the Military Department Secretary (or Agency Head) determines the MDAP or 
Major Subprogram has breached the critical cost growth threshold, the USD(A&S) 
will commence actions required by 10 USC § 4376. 

(3) If the Secretary determines the MDAP or Major Subprogram has breached the 
significant or critical cost growth threshold, the USD(A&S) will commence actions 
required by 10 USC § 4375, and provide the following additional information in the 
MSAR: 

(a) PAUC and/or APUC Breach Explanations, including any change in End-Item 
Quantity since Current Baseline and Original Baseline 

(b) Impacts of Schedule Changes on Unit Cost 

(c) Impacts of Performance Changes on Unit Cost 

(d) Actions Taken or Proposed to Control Future Cost Growth 

2.8. LIFE-CYCLE COSTS 

MSAR Operating and Support (O&S) estimates should be consistent with the APB’s O&S 
assumptions and scope.  For example, the O&S scope for a modification program could be a 
system component or subsystem, or it could be the modified system overall.  

If the program acquires multiple systems or variants with significantly different characteristics 
and planned usage, these should be reported separately, and these acquired systems and their 
antecedent systems must be identified in Program Attributes before initiating the PPS. 

a. OSD CAPE has cancelled “Base Year dollars” (BY$) as a valid dollar type because it can 
be taken to mean Constant Year dollars (CY$) or Constant Price (CP$).  

(1) While the DAVE user interface still uses BY$ labels, program offices should ensure 
CY$ estimates are provided in both DAVE and the MSAR Supplement Workbook 
(see Sections 3.14 and 3.15). 

(2) The PDFs generated from DAVE and the Workbook will display CY$ labels, and in 
the future the DAVE user interface will be updated as well. 

b. O&S Cost Estimates by Cost Category and Acquired System 

(1) O&S Cost Categories are defined by the OSD Cost Assessment and Program 
Evaluation (CAPE) O&S Cost-Estimating Guide: 
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(a) 1.0 Unit-Level Manpower 

(b) 2.0 Unit Operations 

(c) 3.0 Maintenance 

(d) 4.0 Sustaining Support 

(e) 5.0 Continuing System Improvements 

(2) Provide the Current Cost Estimate for each category in BY$ for each weapon system 
and system variant acquired by the MDAP or Major Subprogram. 

(3) Ensure Category totals for each system are consistent with the Annual O&S Estimates 
provided in the MSAR Workbook (Section 3.15 below) 

(4) Estimate Source includes type (e.g., SCP, ICE), approval authority and date 

c. O&S and Disposal Costs Compared with Baseline and Deviation Explanation 

(1) Provide the Total O&S estimate for the MDAP (or Major Subprogram) in TY$.  The 
total estimate in BY$ will be summed from the system O&S estimates by category. 

(2) Ensure an O&S Deviation is indicated if the base year estimate is greater than the 
APB base year threshold and provide an explanation.  

(a) Explain a new deviation. 

(b) If a deviation existed in the prior MSAR, provide an explanation if the estimate 
grown more than 5% since the prior MSAR.  Otherwise, the explanation need 
only note that the deviation was reported previously.  For example, “The O&S 
deviation was reported in the December 2022 SAR.” 

(3) Provide the Total Disposal Current Estimate for the MDAP (or Major Subprogram) if 
one exists in TY$ and BY$.  Deviations are not applicable for Disposal Cost. 

d. Cost Estimates Sources: provide source data for the current O&S and Disposal 
estimates, including type (e.g., POE, CCP, CCE, ICE), approval authority and date. If 
applicable, provide a No Estimate Reason for O&S cost and/or Disposal cost. 

e. O&S Cost Variance by Cost Category compares the program’s current estimate with its 
prior approved estimate, whenever it was accomplished (not necessarily an MSAR-to-
MSAR comparison). 

(1) Provide the prior total O&S estimate for the MDAP (or Major Subprogram) and its 
approval date. 
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(2) Allocate the differences between the prior and current estimate by cost category and 
provide an explanation for each variance. 

f. Annual O&S Costs per Unit Compared with Antecedent System 

(1) Provide the Current Estimate for annual O&S Cost per Unit by CAPE cost category 
for each acquired system and system variant, as well as at least one antecedent system 
if applicable.  If an acquired system is replacing more than one antecedent system, 
only the costs of one antecedent should be provided. 

(2) For modification programs, O&S estimate comparisons with the antecedent system is 
left to the CAE discretion.  In some cases, the antecedent system would be the 
unmodified system. 

g. O&S Estimate Assumptions 

(1) Provide quantitative assumptions used for the Acquired and Antecedent System 
estimates: 

(a) End-Item Quantity to Sustain 

(b) Unit Expected Service Life (average) 

(c) Quantity Unit of Measure (e.g., aircraft) 

(d) First Operational Fiscal Year (typically IOC) 

(e) Final Operational Fiscal Year 

(2) Additional O&S Estimate Assumptions and Antecedent Estimate Assumptions: 
Provide amplifying information in these narratives if needed. 

h. O&S Annual Cost Calculation Memo: Identify how the Annual O&S Costs per Unit 
were calculated or estimated. If the estimated costs are at “steady-state” instead of true 
averages over the life cycle, identify the steady-state timeframe. 

2.9. TECHNOLOGIES AND SYSTEMS ENGINEERING 

a. Significant Technical Risks:   

(1) Identify current technical risks as of the date of the MSAR submission. 

(2) Identify prior risks that existed at the time of each milestone review. 

(3) Provide negative statements if applicable, e.g., “There are currently no technical 
risks,” or “There were no technical risks identified at Milestone B.” 
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2.10. PERFORMING ACTIVITIES AND CONTRACTS 

Identify Government and Commercial Activities funded by the MDAP or Major Subprogram. 

a. External Government Activities: Identify other government entities such as test, 
training, or logistics activities funded by the acquisition program. 

(1) Activity Title 

(2) Supported Phase: Development, Production, or Sustainment 

(3) Commercial and Government Entity (CAGE): Code, Legal Name, City, State.  
Refer to https://cage.dla.mil/. 

(4) Work Start Date 

b. Contract Identification: Identify each of the program’s active contracts (including 
services contracts) that qualify for Cost and Software Data Report (CSDR) 
requirements.5F

6 Reporting on other contracts is at the discretion of the CAE. For each 
covered contract, provide: 

(1) Contract Number, Order Number (if applicable), Contract Title 

(2) Contract Strategy (select the dominant type if more than one applies) 

(3) CAGE Code, Legal Name, City, State 

(4) Contracting Office 

c. Effort Identification:  

(1) Effort Number: PMO-defined and represents a discrete portion (or portions) of a 
contract that should be tied to the contractor reporting activities as defined in the 
contract CDRL.  The contract/effort pair must be unique since it is the “primary key” 
for contract status and Earned Value Management (EVM) reporting.   

(2) Supported Phase: Contracts that support more than one phase (e.g., production and 
sustainment) should be apportioned into efforts if possible.  Otherwise, identify the 
predominant phase.  

(3) Contract Type: select “Multiple Types” if more than one applies and explain in the 
Contract Notes (e.g., CPIF 50%, FFP 30%, FPIF 20%) 

 
6 CSDR reports in DoDI 5000.73 Table 1 are Contractor Cost Data Report, Software Resources Data Report, 
Contractor Business Data Report, Maintenance and Repair Parts Data Report and Technical Data Report. Generally, 
for ACAT I-II Programs, CSDRs apply to contracts valued at more than $50 million (or software contracts valued at 
more than $20 million) and other contracts in the CSDR plan.  

https://cage.dla.mil/
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(4) Award Date: Only include awarded contracts (including undefinitized contract 
actions).  

(5) Definitization Date (if applicable) 

(6) Latest Modification Date and Number (if applicable) 

(7) Work Start Date 

(8) Technical Data Rights (select the dominant type if more than one applies) 

(9) Notes:  

(a) Indicate whether the Contract Data Requirements List (CDRL) includes CSDRs, 
i.e., “The CDRL includes CSDRs” or “The CDRL does not include CSDRs.” 

(b) Specify the effective date of the reported Contract Performance data. For cost or 
incentive type contracts, this should be the date of the most recent Contract 
Performance Report (CPR). 

d. Contract Performance (all amounts in TY$): Target Price data is required for all 
contract types.  Earned Value Management (EVM) data should be current as of the date 
of the latest CPR. 

(1) Initial Target Price and Current Target Price: Explain significant differences. 
These should match for Firm-Fixed-Price (FFP) contracts. 

(2) Initial Ceiling Price and Current Ceiling Price (applicable for fixed price incentive 
fee (FPIF) contracts): Explain significant differences 

(3) Contractor’s Estimate at Completion and Program Manager’s Estimate at 
Completion: Explain significant differences. These should match for Firm-Fixed-
Price (FFP) contracts.  

(4) Earned Value Management Performance: Provide for cost- and incentive-type 
contract/efforts.  

(a) Work Completed (%), Cost Variance and Schedule Variance: Derived by 
Budget at Completion, Budgeted Cost for Work Scheduled, Budgeted Cost for 
Work Performed, and Actual Cost of Work Performed  

(b) Factors Contributing to Cost Variance CV and Projected Effects on Program 
Costs 

(c) Factors Contributing to Schedule Variance and Projected Effects on 
Program Schedule 
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2.11. PRODUCTION 

Identify the Milestone Decision Authority (MDA) original and latest Low-Rate Initial 
Production (LRIP) Determination for the MDAP or Major Subprogram.6F

7 

a. Original LRIP Determination  

(1) Total LRIP Quantity  

(2) Date determination was made, typically the LRIP Acquisition Decision 
Memorandum (ADM) date 

(3) Reference: typically the LRIP ADM documenting the decision 

(4) LRIP Period: first and final fiscal years of production lots 

(5) Total Procurement Quantity for the baselined program at the time decision was 
made 

(6) LRIP Percentage of Total: calculated by dividing the Total LRIP Quantity by the 
Total Procurement Quantity as of the date of the determination 

b. Current LRIP Determination: Provide data for the latest LRIP Determination.  Provide 
the same values if the Current Determination is the Original Determination. 

c. Provide a Rationale if LRIP Quantity Exceeds 10% of Total Procurement Quantity 

2.12. DELIVERIES AND EXPENDITURES 

a. Acquisition Funding Completion Status: 

(1) Years Appropriated: actual number of years of congressional budget appropriations 
for MDAP or Major Subprogram as a percentage of total estimate of budget 
appropriation years required. 

(2) Funding Appropriated: actual amount of congressional budget appropriations for 
MDAP or Major Subprogram as a percentage of total estimate of acquisition funding 
required. 

(3) Expenditures: actual expenditures of budget appropriations for MDAP or Major 
Subprogram as a percentage of total estimate of acquisition funding required. 

b. End Item Deliveries Completion Status: 

 
7 10 USC § 4231 (a)(5) 
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(1) Actual number of program end items formally delivered to the U.S. Government 
(apportioned by acquired system or variant) as a percentage of total required 
acquisition end items. 

c. Notes: Indicate the effective date(s) for these measures of completion status. This is 
typically the effective date of the MSAR but may be another date prior to the date the 
MSAR was published. 

2.13. SUSTAINMENT 

PPS Sustainment data is not required.  Any data provided will not be transmitted to the Advana 
Congressional Stream and will not be published in the MSAR PDF.   

2.14. INTERNATIONAL PROGRAM ASPECTS 

a. General Memo: Summary narrative pertaining to the MDAP’s or Major Subprogram’s 
International Program Aspects. 

b. Exportability and Business Issues7F

8: Summarize potential impacts on the program from 
leveraging Foreign Military Sales (FMS), Direct Commercial Sales (DCS) and 
International Cooperative Program (ICP) procurements, industry partner cost-sharing 
contributions to exportability, cost savings, and other strategic/operational benefits to 
U.S. and partners for making a system available for foreign sales sooner due to 
exportability design efforts. 

(1) Is design for international exportability planned?  

(2) If not, has the MDA approved an exportability waiver for a U.S.-only design? 
(Required for MDAPs by DoDI 5000.85 Para. 3C.4.a). 

(3) Industry/Partner Exportability Cost-Sharing? Indicate whether the program 
contains any contract with a cost-sharing provision that requires the contractor to bear 
half of the cost to enable the exportability of the system (either for development of 
program protection strategies for the system or the design and incorporation of 
exportability features into the system), or such other portion as the Secretary 
considers appropriate upon showing of good cause. 

c. Program Protection: Technology Security and Foreign Disclosure Issues: Summarize 
impacts on Supply Chain Assurance, Information Assurance, Anti-Tamper, Analysis of 
Critical Program Information (with program identification of status of CPI analysis, any 
inherited CPI and source program, and whether program has conducted horizontal 
protection for CPI and critical systems), and Exportability. 

 
8 DoDI 5000.85, Appendix 3C, Para. 3C.4.a 
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d. Agreements: Identify FMS, DCS and ICP agreements for the MDAP or Major 
Subprograms, including the quantity and estimated cost by recipient country. For FMS, 
only include actual sales; projected or anticipated sales may be mentioned in the General 
Memo but should not be included in the data table.  For each agreement identify: 

(1) International Partner or Partners 

(2) Activity Date, Agreement Type, and Agreement Number  

(3) For each partner, the agreement’s Funding and End-Item Quantity by fiscal year. If 
the Agreement Quantity item is something other than a program end-item, describe 
this in the Agreement Note. 

2.15. SUBMITTING THE DAVE PPS MSAR TO OASD(A)/ADA 

a. Once the CAE staff finalize the DAVE PPS, generate a PDF of the report. 

b. If there is any CUI data, see Appendix C for redaction instructions. 

c. If an amended MSAR PPS is submitted, notify the DAVE Service Desk to remove the 
prior version that it replaces. 

d. Email the PDF to osd.sardata@mail.mil. Use the filename format: “(U) [program short 
name] SAR Dec 2023”, e.g., “(U) AGM-88E ARGM SAR Dec 2023”. 

 

 

 

mailto:osd.sardata@mail.mil
mailto:osd.sardata@mail.mil
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SECTION 3: MSAR SUPPLEMENT WORKBOOK DATA GUIDANCE 

3.1 PREPARATION  

a. The MSAR Supplement workbook does not include “live” source data.  It includes a 
recent snapshot of data from DAVE and other sources:  

(1) Program table (DAVE) 

(2) System table (DAVE) 

(3) Program-System link table (DAVE) 

(4) PB 2024 Cost Accounts and Budget Lines (DAVE, sourced from the OSD(C) Next 
Generation Resource Management System (NGMRS)) 

(5) Account-specific Raw Inflation Rates and Outlay Rates, sourced from indices 
provided by ASN FMB-6 and SAF/FMCE.  See note in Section 2.6. 

b. The workbook is structured to support data entry for programs without subprograms and 
programs with up to four subprograms.  It supports programs and subprograms with up to 
three acquired systems. 

c. ASD(A)/ADA will update the program and system tables in the workbook monthly 
during “MSAR Season” by querying data from the DAVE database, and posting 
workbook updates to https://dave.acq.osd.mil/help/Selected_Acquisition_Report_HELP. 
Notify ASD(A)/ADA immediately (osd.sardata@mail.mil) if there are more than 
four reporting subprograms, more than three acquired systems per program or 
subprogram, or names are incorrect. 

3.2 GENERAL INSTRUCTIONS AND BUSINESS RULES 

a. Classification: Only include Unclassified information in the MSAR Supplement; do not 
include Controlled Unclassified Information (CUI) or classified information.  The top of 
each section of the workbook includes a checkbox the data provider should use to 
indicate that some data in this section cannot be reported because it is not Unclassified.  
Select “x” for the box if that is the case and then enter the information that can be 
provided.  There will be no classified annex for the MSAR Supplement. 

b. The workbook is structured and formatted to facilitate data quality, enable the publication 
of a report PDF, and enable data extraction into the DoD Advana analytics platform.  See 
Appendix B for detailed instructions to submit and publish the MSAR Supplement. 

c. Please observe these instructions to minimize data loss and maintain a standard format 
among the DoD’s reports: 

https://dave.acq.osd.mil/help/Selected_Acquisition_Report_HELP
mailto:osd.sardata@mail.mil
mailto:osd.sardata@mail.mil
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(1) Do not change the sheet names in the workbook.  In most cases these will appear as 
section names in the footer of the PDF report. 

(2) Do not modify or remove the workbook’s hidden sheets that contain source data to 
support data entry.  Note that some of that data is CUI, so maintain the “(CUI)” label 
in the file name of the workbook.  The PDF resulting from publication will not 
include this CUI; it will be Unclassified. 

(3) Maintain sheet protections to permit data entry where it’s needed, prevent 
unintentional corruption of formulas, and the standardized template to enable data 
extraction.  Contact ASD(A)/ADA (osd.sardata@mail.mil) if forms need to be 
adjusted (e.g., rows or columns added) to accommodate data entry. 

(4) The workbook accommodates data entry for a program, or for a program with up to 
four subprograms.  Therefore, most data sections have additional columns to support 
data entry for multiple subprograms. 

(5) Do not adjust column widths of the sheets.  Pages are formatted so that printing the 
sheet or workbook as a PDF would produce in a report suitable for publication.  View 
“Page Break Preview” to see the printable area of each sheet. Prior to publication this 
will be adjusted to “hide” unneeded rows of each worksheet so that unneeded 
columns (e.g., for additional subprograms) are not printed.  See Appendix B for 
details. 

(6) Row heights may be adjusted to display word-wrapped text that would not otherwise 
be displayed in a cell or row. Prior to publication unneeded worksheet rows will be 
“hidden”. 

(7) Avoid using special characters or formatted text in narratives. 

(8) Do not insert links to external sources. 

3.3 COVER PAGE AND INITIAL PROGRAM SETUP 

a. The “Cover” sheet of the workbook is used to identify the report’s primary program 
(typically a Major Defense Acquisition Program (MDAP)) and any Major Subprograms 
that are required to be included in the MSAR (see Section 1.2). 

b. Select the primary program name (typically the MDAP name) in cell C6.  Use optional 
filters for Lead Component, Acquisition Type, and/or Acquisition Status to refine drop-
down selections.  Entering a portion of program name text in cell C6 will also filter the 
selections as “type-ahead” text. 

c. Enter the MSAR Effective Date in cell G3: 12/31 for the Annual MSAR; 3/31, 6/30 or 
9/30 for an Exception MSAR. 

mailto:osd.sardata@mail.mil
mailto:osd.sardata@mail.mil
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d. Next, if the program has one or more reporting subprograms, select them in cells C18, 
E18, G18, and I18. 

e. If the program has no subprograms, select its acquired system or systems in cells C11-
C15. Notify the DAVE  

f. Do not select systems for the program if it has reporting subprograms.  Instead, select 
systems for each subprogram in cells C22-C26, E22-E26, G22-G26, and I22-I26 

g. Leave unneeded fields blank. 

h. MSAR Effective Date: For the annual MSAR, this is the last day of the first quarter of 
the fiscal year, e.g., 12/31/2023 for the December 2023 MSAR. For an Exception MSAR, 
this is the last day of the fiscal quarter, i.e., 3/31, 6/30 or 9/30. 

i. Budget Year: The MSAR or Exception MSAR Budget Year is the President’s Budget 
Fiscal Year, so it will always be the Current Fiscal Year plus one. E.g., The Budget Year 
for MSAR’s and Exception MSARs produced during FY2024 will be 2025. 

3.4 PROGRAM DESCRIPTION 

a. The upper portion of the “Program Description” sheet displays descriptive information 
for the MDAP, any reporting Major Subprograms and any acquired systems (selected in 
the “Cover” sheet).  Inaccurate data indicates Program Attributes data in DAVE needs to 
be updated or the workbook needs to be updated with DAVE data. 

b. Related Programs.  In this section identify up to five related programs for the report’s 
primary program. If based on the definitions below there are no related programs then 
leave this table blank. 

(1) Definition: Two or more programs that are part of an incremental or evolutionary 
acquisition strategy.  This could involve program restructures, program increments or 
transitions from one Adaptive Acquisition Pathway to another.   

(a) A program in any pathway may be associated with one or more programs in the 
same or other pathways. 

(b) Identify related programs the parent-program level, not subprogram level. 

(c) References: 

(i) 10 USC § 4351(b)(1) 

(ii) USD(A&S) Memo, Accounting for Program Costs When Acquisition 
Framework Pathways Are Used Sequentially or in Combination, 19 Jul 2022 

(d) Examples:  
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(i) Capability developed under an MTA program transitions into an MCA 
program  

(ii) MTA Rapid Prototyping capability transition to an MTA Rapid Fielding 
program 

(iii) “Block” or “Increment” Programs 

(iv) Restructured Programs 

(2) Select Related Programs from dropdown lists in cells G28-G32.   

(a) Use optional filters in columns A-D for Lead Component, Adaptive Acquisition 
Framework (AAF) Pathway, Acquisition Type, and/or Acquisition Status to refine 
drop-down selections.  Entering a portion of program name text will also filter the 
selections as “type-ahead text.” 

(b) If necessary, adjust the row height to fully display the related program full name 
in column G. 

(3) If the primary program has more than five related programs, add rows to the table: 

(a) Unprotect the sheet (select Review > Unprotect Sheet), then copy the last row of 
the Related Programs table and select Insert Copied Cells. 

(b) Filters used to narrow program selections in column A-D may not work for added 
rows and should be cleared. 

c. Costs in SAR? (Acq): Identify, for each Related Program, whether the acquisition 
estimate of the MSAR’s primary program contains estimated or actual acquisition costs 
for a particular related program pursued under the same or another AAF pathway. 

d. Costs in SAR? (O&S): Identify, for each Related Program, whether the O&S estimate of 
the MSAR’s primary program contains estimated or actual O&S costs for a particular 
related program pursued under the same or another AAF pathway. 

3.5 PROGRAM USE OF THE ADAPTIVE ACQUISITION FRAMEWORK 

a. The “Program Use of the AAF” sheet is formatted to enable data entry for the report’s 
MDAP (not for subprograms). 

b. Definition: A narrative that summarizes a program’s use of the Adaptive Acquisition 
Framework for the overall acquisition plan and interdependencies with related programs 
and pathways.   

(1) This is particularly helpful when a system is acquired through related programs.  
Provide a summary of the logical order and dependencies among the programs and if 
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transitions have occurred or are planned. Identify the milestone or decision point at 
which successive programs began or will begin.   

(2) This is not a history of antecedent systems. 

c. If a long narrative is needed, text in each row of the workbook should be limited to about 
1,500 characters to support data extraction and page breaks in the published report. 

d. If there are no related programs simply state, “This acquisition is accomplished by a 
single program in the Major Capability Acquisition Pathway.” 

3.6 TECHNOLOGIES AND SYSTEMS ENGINEERING 

a. The “Tech & Systems Engineering” sheet is formatted to enable data entry for an MDAP 
with no subprograms or data entry for each Major Subprogram. 

b. Major Software Efforts: List ongoing Major Software Efforts for the program or 
subprogram that will affect delivery of capability to the warfighter, and whose estimated 
costs exceed $50 million each.  The workbook supports identification of up to ten efforts. 
Completed efforts do not need to be included.  

(1) For each effort provide a title, status, expected fielding date, and brief description. 

(2) Status selections are “Design”, “Development” and “Deployment” 

(3) It is unnecessary to include fully deployed software efforts. 

c. Major Engineering Changes: List ongoing Major Engineering Changes that may affect 
scope, cost, or schedule, and whose estimated costs exceed $50 million each.  The 
workbook supports identification of up to ten changes. Completed efforts do not need to 
be included. 

(1) For each change, provide a title, original need date, approval date and a Description, 
Rationale, and Program Impacts 

(2) It is unnecessary to include engineering changes that have been fully incorporated 
into production. 

3.7 FUNDING SOURCES (ACQUISITION) 

This data section identifies the sources of acquisition funding in the President’s Budget for the 
MDAP with no subprograms or each Major Subprogram (efforts within the scope of the APB 
that are planned to be executed by the program office).  For reference, OSD(Comptroller) Next 
Generation Resource Management System (NGRMS) budget data (e.g., accounts, line items, 
program elements, projects) supporting this data section are available at 
https://dave.acq.osd.mil/help/Selected_Acquisition_Report_HELP. 

https://dave.acq.osd.mil/help/Selected_Acquisition_Report_HELP
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a. The “Funding Sources (Acquisition)” sheet is formatted to enable data entry for a 
program with no subprograms or data entry for each subprogram. 

b. Acquisition Funding Notes: Provide any amplifying information regarding acquisition 
funding sources in row 8.  If needed, increase or reduce the height of the row to display 
the full note.  

c. Budget Lines: In the table below the Acquisition Funding Notes, identify each budget 
line that currently funds or budgets for the acquisition program in the President’s Budget 
(PB) and Future Years Defense Program (FYDP).  Include budget lines from all 
applicable appropriation categories (i.e., RDT&E, Procurement, MILCON, Acquisition-
Related O&M, and Revolving & Management Funds (R&MF)). 

d. For the purposes of the MSAR, a budget line is the combination of DoD budget 
accounting codes that identifies a portion of the DoD budget that funds a program:  
 

Descriptor Example Code Example Title 
Account 2040A Research, Development, Test, and Evaluation, Army 
Budget Activity (BA) 07 Operational Systems Development 
Budget Line Item (BLI) 0203744A Aircraft Modifications/Product Improvement Programs 
Program Element (PE) 0203744A Aircraft Modifications/Product Improvement Programs 
RDT&E Project D17 Apache Block III 
Account 2031A Aircraft Procurement, Army 
Budget Activity (BA) 01 Aircraft 
Budget Line Item (BLI) 5757A05111 AH-64 Apache Block IIIA Reman 
Program Element (PE) 0210100A Aviation Procurement - AA 
RDT&E Project   -   - 
Account 2020A Operation and Maintenance, Army 
Budget Activity (BA) 04 Administration and Service-Wide Activities 
Budget Line Item (BLI) 435 Other Service Support 
Program Element (PE) 0207806A Acquisition and Management Support 
RDT&E Project   -   - 
Note: if a particular MILCON or O&M Program Element that funds the program has many Line Items 
Projects, it is acceptable to select one representative and include a note indicating that there are others. 

e. Follow the steps below to find and add a budget line.  (To ensure data quality, the 
workbook uses structured data sourced from the OSD(Comptroller) Next Generation 
Resource Management System (NGRMS), and each budget line has a unique identifier 
(ID)). 

(1) Use the optional filters for Appropriation Category and Department then select 
Account (cells A3-C3). 

(2) Next, select the Budget Line from the filtered list of budget lines in cell B5.  

(3) The Budget Line selections can be filtered further by entering a portion of the text in 
cell B5, then selecting from the filtered list. 
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(a) For example, to find the procurement Budget Line for the Carrier Replacement 
program, use the filters in cells A3-C3 to select “Procurement”, “Navy” and/or 
“1611N” 

(b) The drop-down list in cell B5 will then include all Budget Lines in account 
1611N. 

(c) If a portion of the budget line in known, such as the PE 0204112N, entering 
“0204112N” in cell B5 will then narrow the drop-down list to only those in 
1611N with that PE. 

(d) Note: The NGRMS data in the workbook is current as of PB 2024.  If a budget 
line that supports the program cannot be found, select the Budget Line Item 
“Other” in the given Account and add the details in the Budget Line Note. 

 

(4) Once the Budget Line is identified, copy the Budget Line ID (cell B6), and paste its 
value into cell B12 for the program (or the first subprogram).  To “paste-special” its 
value, right-click in cell B12 then select the “clipboard 123” icon.  Shortcut keys are 
Ctrl+Alt+V, then select Value. 

(5) The structured data for this Budget Line identifier will then be displayed in row 12.  
If needed, increase the height of the row to display the full line item title or RDT&E 
project title. 

(6) Select “x” in the “Shared” column N if the budget line is not dedicated to the 
program, i.e., if it funds programs or efforts in the FYDP in addition to the approved 
(baselined) program or subprogram.  

(7) Select “x” in the “Sunk” column if the PB does not request funding for the approved 
(baselined) program in the budget line in the budget year or FYDP.  Including Sunk 
budget lines is especially informative when the program still has unobligated funds in 
those line items or projects. 

(8) Finally, add a budget line Note in cell I13 if needed for amplifying information, and 
adjust the height of the row to display the full note. 
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(9) Repeat these steps to identify each budget line for the program (or for each 
subprogram). 

3.8 FUNDING SOURCES (O&S) 

This data section identifies the sources of funding in the President’s Budget for Operating and 
Support activities that are executed by the program office (or sustainment office), which 
typically begin as the program prepares for Initial Operational Capability.  It is not necessary to 
identify sources of funding for O&S costs outside the control of the program manager or 
sustainment manager.  

a. The “Funding Sources (O&S)” sheet is formatted to enable data entry for a program with 
no subprograms or data entry for each subprogram. 

b. Operating and Support Funding Notes: Provide any amplifying information regarding 
funding sources for the O&S phase of the life cycle in row 8.  Increase or reduce the 
height of the row if needed to display the full note.  

c. Budget Lines: In the table below the Operating and Support Funding Notes, identify 
each budget line that funds O&S in the President’s Budget (PB) and Future Years 
Defense Program (FYDP).  Include budget lines from all applicable appropriation 
categories (e.g., RDT&E, Procurement, O&M, and MILPERS). 

d. Follow the same steps listed above for “Funding Sources (Acquisition)” to find and add 
O&S budget lines. 

3.9 ACQUISITION & QUANTITY SUMMARY 

a. Except for the Base Year and Unit Description fields, the “Acquisition & Quantity 
Summary” sheet is formatted to be display-only for an MDAP with no subprograms or 
for each Major Subprogram.   

b. Base Year (Current APB): Enter the Current APB base year(s) for the program (or for 
each subprogram) in column F.  These are used for TY$ to CY$ conversions. 

c. Base Year (Original APB): Enter the Original APB base year(s) for the program (or for 
each subprogram) in column H.  These are used to convert estimates to the base year of 
the Original APB. 

d. Unit Description: Provide a simple definition for the “unit” used in the Acquisition End-
Item Quantities table and unit cost calculations.  Provide this for the program (or for each 
subprogram) in row 31. If needed, increase or reduce the height of the row to display the 
full description.  

e. Displayed data are calculated from the workbook’s “Annual Acquisition Estimates” and 
“Annual Acquisition Quantities” sheets: 
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(1) Acquisition Estimates table displays appropriation category totals, Program 
Acquisition Unit Cost (PAUC) and Average Procurement Unit Cost (APUC) in Then-
Year $Millions (TY ($M)) and Constant-Year $Millions (CY ($M)) using: (1) the 
Current APB base year, (2) the Original APB base year, and (3) the MSAR fiscal 
year. 

(2) Acquisition End-Item Quantities table displays Development, Procurement, and 
any O&M-Acquired end item quantities by acquired system. 

(3) Current and Future Years Defense Program Summary (FYDP) table displays—
for each appropriation category—the program’s budget estimate for the current fiscal 
year and FYDP, as well as prior years and to-complete years. 

f. Ensure appropriation category totals, unit costs and quantity totals on this sheet match 
data provided in the MSAR Program Progress Submission (see Section 2.6 Acquisition 
Budget Estimate and Section 2.7 Unit Costs). 

3.10 ANNUAL ACQUISITION ESTIMATES 

a. The “Annual Acquisition Estimates” sheet is formatted to enable data entry for an MDAP 
with no subprograms or data entry for each Major Subprogram (up to twelve 
appropriation accounts.  If data entry is needed for additional appropriation accounts, 
contact ASD(A)/ADA (osd.sardata@mail.mil). 

b. Annual Acquisition Estimates by Appropriation Account: Repeat these steps for each 
appropriation account that comprises the Acquisition Budget Estimate for the program 
(or for each subprogram). 

(1) Select the Subprogram in row 5 (if the MSAR includes subprograms). 

(2) Select the Appropriation Category in row 7.  Only select O&M if that appropriation 
category funds a portion of the Total Acquisition Cost. 

(3) Select the Appropriation Account in row 8. 

(4) Indicate if Non-Treasury (e.g., foreign) sources fund the Appropriation Category by 
checking the box in row 9.  In this case you can still select a DoD Account in row 8 to 
use for the TY$-CY$ conversions. 

(5) Source for TY$ to CY$ conversion is displayed in row 18. 

(a) Unless otherwise indicated in row 10, the source will be ASN FMB-6 Inflation 
Rates and Outlay factors for Army, Navy, and Defense Wide accounts, or 
SAF/FMCE for Air Force accounts. 

(b) If the Milestone Decision Authority has approved the use of alternate, program-
specific weighted rates check the box in row 10 and identify the source. 

mailto:osd.sardata@mail.mil
mailto:osd.sardata@mail.mil
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(6) Enter the annual acquisition estimates—in TY($M)—in the table. 

(a) If the Appropriation Category is “Procurement”, allocate the total annual amount 
using the displayed categories.  Note “Depot Activation” is a new category 
required by ASD(S) for fiscal years beginning with 2023. 

(i) End Item Recurring Flyaway: Procurement cost or appropriated funding 
associated with the specific end item quantity of the primary unit of measure. 
Recurring are the efforts that occur repeatedly during the development or 
production process (e.g., material, labor, and other expenses incurred in 
support of final system production). Flyaway are the efforts related to 
producing a usable end item of military hardware. Includes the cost of 
creating the basic unit (airframe, hull, chassis, etc.), an allowance for changes, 
propulsion equipment, electronics, armament, other installed Government-
Furnished Equipment (GFE), and nonrecurring start-up production costs. An 
analogous term is “rollaway cost” for military vehicles and “sail-away cost” 
for naval vessels. Procurement is the program investment funding for 
acquisition, production, and modification of equipment, supplies, materials, 
services, and spare parts. 

(ii) Non-End Item Recurring Flyaway: Procurement cost or appropriated 
funding not associated with the specific quantity of the primary unit of 
measure. Recurring are the efforts that occur repeatedly during the 
development or production process (e.g., material, labor, and other expenses 
incurred in support of final system production). Flyaway are the efforts related 
to producing a usable end item of military hardware.  

(iii)Non-Recurring Flyaway: Procurement cost or appropriated funding used for 
one-time assembly line setup and shutdown costs, special tooling, and other 
nonrecurring costs associated with producing the end items, such as 
preproduction engineering, initial spoilage and rework, and specialized work 
force training.  

(iv) Initial Spares: Procurement cost or appropriated funding used for deliverable 
spare components, assemblies, and subassemblies used for initial replacement 
purposes.  

(v) Depot Activation: Procurement cost or appropriated funding used to establish 
or activate Integrated Product Support requirements outlined in the 
maintenance plan, as well as activities required to achieve a depot 
maintenance capability for each specified system. This includes the delivery 
of required supportability data. 

(vi) Other/Unallocated: Additional procurement cost or appropriated funding not 
allocated to one of the above categories.  May include tech data, manuals, 
training devices, peculiar support equipment, and services. 
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(b) If the Appropriation Category is not “Procurement”, provide the total annual 
amount in the “Other/Unallocated” column. 

(c) Prior Year amounts:  Provide actual obligation amounts for fiscal years in which 
the account is no longer active.  Provide current budget authority for fiscal years 
in which funds have been appropriated and are still active. 

(d) Current Year amount: Provide current budget authority. 

(e) Budget Year (BY) through BY+4 amounts: Provide budgeted amounts 
consistent with the current budget position (the President’s Budget for an MSAR). 

(f) To Complete amounts: For fiscal years beyond BY+4, provide the annual 
budgets required to complete the program, assuming the FYDP budget is fully 
funded. 

(g) Weighted Rate: the weighted rate is derived using the program’s Current APB 
Base Year and official inflation indices and outlay rates provided by ASN FMB-6 
and SAF/FMCE.  If the MDA has approved the use of alternate, program-specific 
weighted rates, unprotect the sheet, insert the weighted rates for the account, and 
identify the source in row 10. Note that the use of alternate weighted rates is 
very rare; consult with your CAE’s MSAR POC before using these. 

(7) To standardize the ordering of Acquisition Estimates by Account tables in the 
published MSAR Supplement, please provide data in this order: 

(a) If the program has subprograms, create all tables for the first subprogram before 
creating tables for the next subprogram(s). 

(b) Appropriation Category order: RDT&E, Procurement, MILCON, O&M, R&MF 

(c) Appropriation Accounts within each category (if more than one): Army, Navy, 
Air Force, Defense-Wide, and then in numeric order if more than one per 
department. 

c. Total Annual Acquisition Estimates for all accounts are summed in column D, for 
reference, to make it clear which “Prior” and “To Complete” fiscal years can be hidden 
when publishing the report. 

3.11 ANNUAL ACQUISITION QUANTITIES 

a. The “Annual Acquisition Quantities” sheet is formatted to enable data entry for an 
MDAP with no subprograms or data entry for each Major Subprogram (up to six 
appropriation accounts for Development, Procurement, and any O&M-Acquired 
Quantities.  If data entry is needed for additional appropriation accounts, contact 
ASD(A)/ADA (osd.sardata@mail.mil). 

mailto:osd.sardata@mail.mil
mailto:osd.sardata@mail.mil
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b. Annual Acquired System End-Item Quantities by Appropriation Account: Repeat 
these steps for each appropriation account that comprises the Acquisition Budget 
Estimate for the program (or for each subprogram). 

(1) Select the Subprogram in row 5 (if the MSAR includes subprograms). 

(2) Select the Appropriation Category in row 7.  Only select O&M if the program is 
approved to use that appropriation category to acquire program end-items (this is 
rare). 

(3) Select the Appropriation Account in row 8. 

(4) For each of the program’s (or subprogram’s) acquired systems, enter the annual end-
item quantities aligned with the fiscal year acquisition budget estimates.  A warning 
will appear if no acquired systems have been identified in the Cover sheet. 

(a) Undistributed: Provide end-item quantities in the “Undistributed” table row if 
quantities cannot be aligned with specific fiscal years, not withstanding the Full 
Funding policy of the DoD Financial Management Regulation, DoD 7000.14-R, 
Volume 2A, Section 010202. Undistributed quantities may not be used for 
Procurement appropriation accounts.  

(b) Prior Year amounts:  Provide end-item quantities associated with actual 
obligation amounts for fiscal years in which the account is no longer active.  
Provide planned quantities associated with the budget authority for fiscal years in 
which funds have been appropriated and are still active. 

(c) Current Year (CY) amount: Provide planned quantities associated with current 
budget authority. 

(d) Budget Year (BY) through BY+4 amounts: Provide budgeted quantities 
consistent with the current budget position (the President’s Budget for an MSAR). 

(e) To Complete amounts: For fiscal years beyond BY+4, provide the annual 
quantities required to complete the program, assuming the FYDP budget is fully 
funded. 

(5) To standardize the ordering of Acquired System Quantities by Account tables in the 
published MSAR Supplement, please provide data in this order: 

(a) If the program has subprograms, create all tables for the first subprogram before 
creating tables for the next subprogram(s). 

(b) Appropriation Category order: RDT&E, Procurement, O&M 
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(c) Appropriation Accounts within each category (if more than one): Army, Navy, 
Air Force, Defense-Wide, and then in numeric order if more than one per 
department. 

c. Total Annual Acquisition Quantities for all accounts are summed in column E, for 
reference, to make it clear which “Prior” and “To Complete” fiscal years can be hidden 
when publishing the report. 

3.12 NUCLEAR COSTS 

a. The “Nuclear Costs” sheet is formatted to enable data entry for an MDAP with no 
subprograms or data entry for each Major Subprogram. 

b. Program's Use of Department of Energy Resources: Describe the program's use of 
DOE resources (if any).  

(1) Include total costs (in TY $M) for program-related nuclear armament and propulsion. 

(2) Source of the data (e.g., Department of Energy, Defense Threat Reduction Agency, 
etc.). 

(3) Enter “None” if the program has no DOE funding. 

c. These are “non-add basis” costs; that is, they are not to be included in the program’s 
Acquisition Budget Estimate or Operating and Support Estimate. 

3.13 OPERATIONAL FIELDING PLAN 

a. The “Operational Fielding Plan” sheet is formatted to enable data entry for the acquired 
systems of the MDAP or Major Subprograms. Repeat these steps to provide the 
Operational Fielding Plan for each acquired system of the program (or of each 
subprogram): 

(1) Select the program’s System in row 5 (if the MSAR does not include subprograms). 

(2) Or, if the MSAR includes subprograms, select the Subprogram in row 7 and its 
System in row 9. 

(3) Fielding and Inventory Notes: Provide any amplifying information regarding the 
system’s operational fielding (or beddown) plan and inventory in row 19, that are 
used to calculate system O&S estimates.  If needed, increase or reduce the height of 
the row to display the full note. 

(4) Fielding Plan and Inventory: This table for the Dec 2023 MSAR is formatted to be 
prospective (with estimates) but in the future, actual amounts will be provided for 
prior years (beginning with FY24).  Provide estimates for each category through the 
FYDP. 
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(a) Inventory: Provide the end of fiscal year 2023 operational inventory in cell Q23. 

(b) Store: For each fiscal year, provide the projected net number of operational 
systems that will be placed in storage (if any).  Enter a negative number if a net 
quantity will be removed from storage.  

(c) Field: For each fiscal year, provide the projected net number of operational 
systems that will be fielded for operational use (if any). 

(d) Expend/Loss: For each fiscal year, provide the projected net number of 
operational systems that will be expended (if any) for systems such as missiles.  
In the future, operational losses will also be reported in this column.  

(e) Decommission: For each fiscal year, provide the projected net number of 
operational systems that will be decommissioned or otherwise intentionally 
removed from the operational inventory (if any). 

3.14 O&S INDEPENDENT COST ESTIMATE 

a. The “O&S Independent Cost Estimate” sheet is formatted to enable data entry for the 
MDAP or for each Major Subprogram.  

b. Repeat these steps to provide a comparison of the O&S Current Estimate (CE) with the 
most recent Independent Cost Estimate (ICE) for the program (or for each subprogram). 
If a CE or ICE does not yet exist for the program or subprogram, state this in the 
corresponding Note field. 

(1) Select the Subprogram in row 5 (if the MSAR includes subprograms). 

(2) O&S Independent Cost Estimate Source: provide the following information 
regarding the latest ICE: 

(a) Event: the occasion requiring the ICE in row 9. 

(b) Estimate Type: “Independent Cost Estimate”, “Component Cost Estimate”, 
“Component Cost Position”, or “Other” in row 10.  Specify the Other Type in 
row 11 if applicable. 

(c) Estimate Approval Authority: “OSD Cost Assessment & Program Evaluation”, 
“Center for Army Analysis”, “Center for Naval Analyses”, “Air Force Cost 
Analysis Agency”, or “Other” in row 12. Specify the Other Approval Authority 
in row 13 if applicable. 

(d) Approval Date: row 14. 

(3) O&S Current Estimate Source: provide similar information regarding the CE in 
rows 17-21. 
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(4) Independent and Current Cost Estimate Comparison:  provide the total program 
amounts in CY$ for each O&S cost element of the ICE and CE in columns I and J. 

(5) ICE Note: provide amplifying information regarding the ICE in row 43. 

(6) Current Estimate Note: provide amplifying information regarding the CE in row 48. 

(7) Cost Estimate Variance Explanation: Summarize the primary contributions to the 
differences between the ICE and the CE in row 51. If needed, increase or reduce the 
height of the row to display the full note.  If there is no ICE or no CE, state “Not 
applicable.” 

3.15 ANNUAL O&S ESTIMATES 

a. The “Annual O&S Estimates” sheet is formatted to enable data entry for acquired 
systems of an MDAP or each Major Subprogram. This is the O&S CE by fiscal year. If a 
CE does not yet exist for the program or subprogram, create table headers for each 
acquired system—steps c(1) and c(2) below—but leave the table blank. 

b. Base Year (Current APB): The Current APB base year(s) for the program (or for each 
subprogram) are displayed in rows 3-7 of column F (referencing the base years entered in 
the “Annual Acquisition Estimates” sheet).   

c. Annual O&S Estimates by Cost Element: Repeat these steps for each acquired system 
that comprises the Current O&S Estimate for the program (or for each subprogram). 

(1) Select the program’s System in row 5 (if the MSAR does not include subprograms). 

(2) Or, if the MSAR includes subprograms, select the Subprogram in row 7 and its 
System in row 9. 

(3) Source for TY$ to CY$ conversion is collected in row 12 and displayed in row 24. 

(4) Enter the Annual O&S Estimates by Cost Element in CY($M) in the base year of 
the Current APB.  Enter costs for each applicable fiscal year of the acquired system. 

d. Data Exists? in column K is provided, for reference, to make it clear which “Prior” and 
“To Complete” fiscal years can be hidden when publishing the report. 
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APPENDIX A: COMMON DOD ABBREVIATIONS 
 

$B Billions of Dollars 

$K Thousands of Dollars 

$M Millions of Dollars 

ACAT Acquisition Category 

ADM Acquisition Decision Memorandum 

APB Acquisition Program Baseline 

APPN Appropriation 

APUC Average Procurement Unit Cost 

Acq O&M Acquisition-Related Operations and Maintenance 

BA Budget Authority/Budget Activity 

BY Base Year 

Blk Block 

CAE Component Acquisition Executive 

CAPE Cost Assessment and Program Evaluation 

CARD Cost Analysis Requirements Description 

CDD Capability Development Document 

CLIN Contract Line Item Number 

CPD Capability Production Document 

CY Constant Year 

DAB Defense Acquisition Board 

DAE Defense Acquisition Executive 

DAMIR Defense Acquisition Management Information Retrieval 

DAVE Defense Acquisition Visibility Environment 

DSN Defense Switched Network 

DoD Department of Defense 

EMD Engineering and Manufacturing Development 

EVM Earned Value Management 

FD Full Deployment 

FDD Full Deployment Decision 
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FMS Foreign Military Sales 

FOC Full Operational Capability 

FRP Full Rate Production 

FY Fiscal Year 

FYDP Future Years Defense Program 

ICD Initial Capabilities Document 

ICE Independent Cost Estimate 

IOC Initial Operational Capability 

IT Information Technology 

Inc Increment 

JROC Joint Requirements Oversight Council 

KPP Key Performance Parameter 

LRIP Low Rate Initial Production 

MDA Milestone Decision Authority 

MDAP Major Defense Acquisition Program 

MILCON Military Construction 

MSAR Modernized Selected Acquisition Report 

MTA Middle Tier of Acquisition 

N/A Not Applicable 

O Objective 

O&M Operations and Maintenance 

O&S Operating and Support 

ORD Operational Requirements Document 

OSD Office of the Secretary of Defense 

PAUC Program Acquisition Unit Cost 

PB President’s Budget 

PE Program Element 

PEO Program Executive Officer 

PM Program Manager 

POE Program Office Estimate 

RDT&E Research, Development, Test, and Evaluation 
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SAR Selected Acquisition Report 

SCP Service Cost Position 

T Threshold 

TBD To Be Determined 

TY Then Year 

U.S.C United States Code 

UCR Unit Cost Reporting 

USD(A&S) Under Secretary of Defense (Acquisition and Sustainment) 

USD(AT&L) Under Secretary of Defense (Acquisition, Technology and Logistics) 
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APPENDIX B: PUBLISHING THE MSAR SUPPLEMENT REPORT 

B.1. GENERAL GUIDANCE 

The MSAR Supplement data collection workbook is structured and formatted to facilitate data 
quality, to enable the publication of a report PDF, and to enable data extraction into the DoD 
Advana analytics platform.   

Please observe these instructions to minimize data loss and maintain a standard format among 
the DoD’s reports: 

a. Do not change the sheet names in the workbook.  In most cases these will appear as 
section names in the footer of the PDF report. 

b. Do not modify or remove the workbook’s hidden sheets that contain source data to 
support data entry.  Note that some of that data is CUI, so maintain the “(CUI)” label in 
the file name of the workbook.  The PDF resulting from publication will not include this 
CUI marking; it will be marked Unclassified. 

c. Maintain sheet protections to permit data entry where it’s needed, prevent unintentional 
corruption of formulas, and the standardized template to enable data extraction.  Contact 
ASD(A)/ADA (osd.sardata@mail.mil) if forms need to be adjusted (e.g., rows or 
columns added) to accommodate data entry. 

d. The workbook accommodates data entry for a program, or for a program with up to three 
subprograms.  Therefore, most data sections have additional columns to support data 
entry for multiple subprograms. 

e. Do not adjust column widths of the sheets.  Pages are formatted so that printing the sheet 
or workbook as a PDF would produce a report suitable for publication.  View “Page 
Break Preview” to see the printable area of each sheet. Prior to publication this will be 
adjusted to “hide” unneeded rows of each worksheet so that unneeded columns (e.g., for 
additional subprograms) are not printed.  See detailed instructions below. 

f. Row heights may be adjusted if needed to display word-wrapped text that would not 
otherwise be displayed in a cell or row. Prior to publication unneeded worksheet rows 
will be “hidden”. 

g. Avoid using special characters or formatted text in narratives. 

h. Do not insert links to external sources. 

mailto:osd.sardata@mail.mil
mailto:osd.sardata@mail.mil
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B.2. PUBLISHING THE MSAR SUPPLEMENT IN PORTABLE DOCUMENT 
FORMAT (PDF) 

Follow the steps below to prepare the workbook for publication as a report PDF.  After preparing 
the sheets, select File > Print, then select “Adobe PDF” as the Printer and under Settings, select 
“Print Entire Workbook”: 

 

 

Workbook Sheet Formatting Instructions: 

a. Cover 

(1) No formatting changes are needed.   

(2) Ensure MSAR Effective Date is correct. 
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(3) Ensure subprograms are selected. 

(4) Ensure the program’s system or system variant(s) are selected for a report without 
subprograms. 

(5) Otherwise, ensure the subprograms’ system or system variant(s) are selected. 

(6) Printable area is columns B-E and rows 28-49. 

b. Info 

(1) No formatting changes are needed.   

(2) Printable area is column B beginning at row 12. 

c. Program Description 

(1) If report does not include Subprograms, select and hide rows 19-24.  If report 
includes fewer than four subprograms, hide unused rows. (Right-click on the row 
numbers and select “hide”). 

(2) If the report’s primary program does not have any Related Programs, keep one empty 
row displayed in the Related Programs table and hide the other rows. 

 
 

(3) See the Program Description section instructions for adding Related Program rows if 
needed. 

(4) Adjust the height of rows within this section to fully display program, subprogram, 
and system names.  

(5) Printable area is columns G-N beginning with row 3.   

(6) Adjust the printable area if needed: View > Page Break Preview   

d. Program Use of the Adaptive Acquisition Framework 
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(1) No formatting changes needed.   

(2) Printable area is column B beginning at row 4. 

e. Technologies and Systems Engineering 

(1) Sheet supports data entry for a single program, or up to four subprograms. 

(2) Hide unneeded pages for subprograms by adjusting the printable area:  In View > 
Page Break Preview, drag the right-hand boarder of the printable area to the left. 

(3) Adjust the height of rows within this section to fully display information for the 
program or all subprograms.  

(4) Hide unneeded rows in the Major Software Efforts and Major Engineering Changes 
tables, but if there are no Efforts (or Change), keep one empty row in the table 
displayed. 

 

f. Funding Sources (Acquisition) and Funding Sources (O&S) 

(1) Sheet supports data entry for a single program, or up to four subprograms. 

(2) Hide unneeded pages for subprograms by adjusting the printable area (View > Page 
Break Preview). 

(3) Adjust the height of row 8 to fully display the Acquisition Funding Notes (and 
Operating and Support Funding Notes) for the program (or all subprograms).  
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(4) Adjust the height of budget line rows to fully display Line Item and RDT&E Project 
names and budget line notes for the program or all subprograms.  

(5) Hide unneeded budget lines rows. 

g. Acquisition Estimate and Quantity Summary 

(1) Sheet supports data entry for a single program, or up to four subprograms. 

(2) Hide unneeded pages for subprograms by adjusting the printable area (View > Page 
Break Preview). 

(3) Adjust the height of row 31 to fully display the Unit Description for the program (or 
all subprograms).  

h. Annual Acquisition Estimates by Appropriation Account 

(1) Sheet supports data entry for up to fourteen appropriation accounts.  

(2) Hide unneeded pages for accounts by adjusting the printable area (View > Page Break 
Preview). 

(3) Hide unnecessary “Prior” and “To Complete” fiscal year rows in the tables in which 
there are no estimates in any accounts.  Reference the “All Accounts Total TY($M)” 
amounts in column B to see which fiscal years have no estimates. 

i. Acquired System Annual End-Item Quantities by Appropriation Account 

(1) Sheet supports data entry for up to six appropriation accounts.  

(2) Hide unneeded pages for accounts by adjusting the printable area (View > Page Break 
Preview). 

(3) Hide unnecessary “Prior” and “To Complete” fiscal year rows in the tables in which 
there are no end-item quantities in any accounts.  Reference the “All Accounts Total” 
amounts in column E to see which fiscal years have no quantities. 

j. Nuclear Costs 

(1) Sheet supports data entry for a single program, or up to four subprograms. 

(2) Hide unneeded pages for subprograms by adjusting the printable area (View > Page 
Break Preview). 

(3) No other formatting changes are needed. 

k. Operational Fielding Plan 
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(1) Sheet supports data entry for up to six acquired systems.  

(2) Hide unneeded pages for systems by adjusting the printable area (View > Page Break 
Preview). 

(3) Adjust the height of row 19 to fully display the Fielding and Inventory Notes for all 
systems.  

l. O&S Independent Cost Estimate 

(1) Sheet supports data entry for a single program, or up to four subprograms. 

(2) Hide unneeded pages for subprograms by adjusting the printable area (View > Page 
Break Preview). 

(3) If there is no Independent Cost Estimate for the program or for any subprogram, hide 
rows 39-44. 

(4) If there is no Current Estimate for the program or for any subprogram, hide rows 45-
49. 

(5) Adjust the height of rows 43 and 48 to fully display the Estimate Source Notes for the 
program or all subprograms.  

(6) Adjust the height of row 51 to fully display the Cost Estimate Variance Explanation 
for the program or all subprograms.  

m. Annual O&S Estimates by Cost Element 

(1) Sheet supports data entry for up to nine acquired systems. 

(2) Hide unneeded pages for accounts by adjusting the printable area (View > Page Break 
Preview). 

(3) Hide unnecessary “Prior” and “To Complete” fiscal year rows in the tables in which 
there are no estimates in any accounts.  Reference the “Data Exists?” column K to see 
which fiscal years have no estimates. 

B.3. SUBMITTING THE MSAR SUPPLEMENT TO OASD(A)/ADA 

a. MSAR Supplement Data Collection Workbook  

(1) Use the filename format: “(CUI) [program short name] MSAR Supplement Dec 
2023”, e.g., “(CUI) AGM-88E ARGM MSAR Supplement Dec 2023” 

(2) “CUI” indicates the workbook contains some hidden sheets with CUI data. 
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(3) Transmit the workbook to osd.sardata@mail.mil via DoD SAFE 
(https://safe.apps.mil/) and then separately email the DoD SAFE decryption password 
to the same email address. 

b. MSAR Supplement PDF  

(1) Use the filename format: “(U) [program short name] MSAR Supplement Dec 2023”, 
e.g., “(U) AGM-88E ARGM MSAR Supplement Dec 2023” 

(2) Email the PDF to the address above. 

 

mailto:osd.sardata@mail.mil
mailto:osd.sardata@mail.mil
https://safe.apps.mil/
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APPENDIX C: REDACTING CUI DATA FROM DAVE MSAR 

C.1. REQUIREMENT 

a. MSARs will be submitted in publicly releasable, unclassified form without any 
designation relating to dissemination control, but may contain a classified annex.    

b. DAVE MSAR data on the NIPRNet: 

(1) Ensure Program Registration information that appears in the PPS (such as the Mission 
and Description narrative) contains no Controlled Unclassified Information (CUI) or 
classified information. 

(2) Ensure current estimates and other information provided in the PPS contain no CUI 
or classified information.  Use the indicator at the top of each PPS data sections to 
specify whether classified data exists and is reported in a SIPR MSAR annex.  

(3) The NIPR DAVE PPS may reference CUI APB data, however—   

(a) Components must manually redact this data from the exported PDF report (see 
below).  

(b) ASD(A)/ADA must redact any CUI data from the PPS before it is transmitted to 
the Advana Congressional Stream. 

C.2. CUI DATA DISPLAYED IN A DAVE MSAR PDF 

a. The PDF of a PPS MSAR with CUI data will have a CUI Designation Indicator on the 
first page and CUI banner markings on every page (Figure C.1). 

b. CUI data will have field-level portion markings, and these markings “roll up” to table 
headers, subsection headers and section headers (Figure C.2) 

C.3. STEPS TO REDACT CUI DATA FROM AN MSAR PDF 

DAVE does not have a feature to generate a redacted PPS PDF.  Follow these steps to edit the 
file, redact the sensitive data, and update the security markings. 

a. Open the file with Adobe Acrobat Pro or a similar PDF editor, then in the “Tools” tab 
select “Edit PDF.”  

b. Locate the CUI data in the document.  Highlight the number, text or date and replace it 
with the word REDACTED in bold font. Then locate portion markings in the table 



MSAR Data Guidance   November 2023  
  
 

Appendix C  48 

 

headers, subsection headers, and section headers and change them to (U) once you are 
sure all CUI data has been redacted (Figure C.3). 

c. Replace “CUI” banner markings on all pages with “UNCLASSIFIED” once you are sure 
all CUI data from the entire report has been redacted.  Finally, remove the CUI 
Designation Indicator on the cover page (Figures C.4).  

 
 

 

 

 

 

 

 

Figure C.1 Figure C.2 
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Figure C.3 Figure C.4 
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